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Are the implementation steps correct and complete?
Did you understand the context of the procedures?
Did you find any errors in the information?
Does the structure of the information help you with your tasks?
Do you need different information or graphics? If so, where, and in what format?
Are the examples correct? Do you need more examples?
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most current Documentation Library plus all documents revised or released recently.
Send your comments to us using the electronic mail address: appsdoc_us@oracle.com
Please give your name, address, electronic mail address, and telephone number (optional).
If you need assistance with Oracle software, then please contact your support representative or Oracle
Support Services.
If you require training or instruction in using Oracle software, then please contact your Oracle local office
and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at
www.oracle.com.
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Preface

Intended Audience
Welcome to Release 12.1 of the Oracle E-Business Suite User's Guide.
This guide assumes you have a working knowledge of the following:
•

The principles and customary practices of your business area.

•

Computer desktop application usage and terminology.

If you have never used Oracle E-Business Suite, we suggest you attend one or more of
the Oracle E-Business Suite training classes available through Oracle University.
See Related Information Sources on page viii for more Oracle E-Business Suite product
information.

Deaf/Hard of Hearing Access to Oracle Support Services
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle
technical issues and provide customer support according to the Oracle service request
process. Information about TRS is available at
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone numbers is
available at http://www.fcc.gov/cgb/dro/trsphonebk.html.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation accessible
to all users, including users that are disabled. To that end, our documentation includes
features that make information available to users of assistive technology. This
documentation is available in HTML format, and contains markup to facilitate access by
the disabled community. Accessibility standards will continue to evolve over time, and
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Oracle is actively engaged with other market-leading technology vendors to address
technical obstacles so that our documentation can be accessible to all of our customers.
For more information, visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise
empty line; however, some screen readers may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any
representations regarding the accessibility of these Web sites.

Structure
1
2
3
A
B

Getting Started with Oracle E-Business Suite
Forms-Based Applications
HTML-Based Applications
Using Help
Oracle E-Business Suite Accessibility Features

Related Information Sources
This book is included on the Oracle E-Business Suite Documentation Library, which is
supplied in the Release 12.1 Media Pack. You can download soft-copy documentation
as PDF files from the Oracle Technology Network at
http://www.oracle.com/technology/documentation/. The Oracle E-Business Suite
Release 12.1 Documentation Library contains the latest information, including any
documents that have changed significantly between releases. If substantial changes to
this book are necessary, a revised version will be made available on the "virtual"
documentation library on My Oracle Support (formerly OracleMetaLink).
If this guide refers you to other Oracle E-Business Suite documentation, use only the
latest Release 12.1 versions of those guides.
Online Documentation
All Oracle E-Business Suite documentation is available online (HTML or PDF).

viii

•

Online Help - Online help patches (HTML) are available on My Oracle Support.

•

PDF Documentation - See the Oracle E-Business Suite Documentation Library for
current PDF documentation for your product with each release. The Oracle

E-Business Suite Documentation Library is also available on My Oracle Support and
is updated frequently.
•

Release Notes - For information about changes in this release, including new
features, known issues, and other details, see the release notes for the relevant
product, available on My Oracle Support.

•

Oracle Electronic Technical Reference Manual - The Oracle Electronic Technical
Reference Manual (eTRM) contains database diagrams and a detailed description of
database tables, forms, reports, and programs for each Oracle E-Business Suite
product. This information helps you convert data from your existing applications
and integrate Oracle E-Business Suite data with non-Oracle applications, and write
custom reports for Oracle E-Business Suite products. The Oracle eTRM is available
on My Oracle Support.

Related Guides
You should have the following related books on hand. Depending on the requirements
of your particular installation, you may also need additional manuals or guides.
Oracle Alert User's Guide
This guide explains how to define periodic and event alerts to monitor the status of
your Oracle E-Business Suite data.
Oracle Workflow User's Guide
This guide describes how users can view and respond to workflow notifications and
monitor the progress of their workflow processes.

Integration Repository
The Oracle Integration Repository is a compilation of information about the service
endpoints exposed by the Oracle E-Business Suite of applications. It provides a
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets
users easily discover and deploy the appropriate business service interface for
integration with any system, application, or business partner.
The Oracle Integration Repository is shipped as part of the E-Business Suite. As your
instance is patched, the repository is automatically updated with content appropriate
for the precise revisions of interfaces in your environment.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data
unless otherwise instructed.
Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as

ix

SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.
Because Oracle E-Business Suite tables are interrelated, any change you make using an
Oracle E-Business Suite form can update many tables at once. But when you modify
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle E-Business Suite.
When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite
automatically checks that your changes are valid. Oracle E-Business Suite also keeps
track of who changes information. If you enter information into database tables using
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes.

x
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Getting Started with Oracle E-Business
Suite

Introduction
Oracle E-Business Suite is a complete set of business applications for managing and
automating processes across your enterprise. This guide describes the user interface
features that are common to Oracle E-Business Suite applications, including:
•

List of Values (LOV), page 2-6

•

Flexfields, page 2-8

•

Search (Query) functions, page 2-9

•

Folders, page 2-11

•

Concurrent Requests, page 2-13

•

Export, page 2-19

•

Attachments, page 2-19

•

User Profile Options, page 2-21
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Getting Started

The Oracle E-Business Suite Home page is your entry point to Oracle E-Business Suite.
From this page you can:
1.

Access Oracle E-Business Suite functions from the Main Menu.

2.

Navigate to frequently-used functions or Web pages from Favorites.

3.

Set Preferences.

4.

View or respond to your most important notifications from the Worklist.

Using Worklists
The Worklist displays your most important notifications. Select the Subject to respond,
or select Full List to see all of your notifications.

Access Oracle E-Business Suite Functions
Use the Main Menu to access Oracle E-Business Suite functions grouped by
responsibility.
Note: A responsibility is a level of authority in Oracle E-Business Suite. It

enables your access to those functions and data appropriate for your
enterprise role. You can have one or more responsibilities.
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To access a function
1.

Select a responsibility to view its menu of functions.

2.

Select the function to launch it.

To add or delete responsibilities shown in the Main Menu from all responsibilities
available to you, select Personalize.
Two Types of Interfaces
Oracle E-Business Suite applications are either Forms-based or HTML-based.
Forms-based applications are optimized for processing a large volume of transactions.
HTML-based applications, sometimes referred to as "self-service applications", are
optimized for ease of first-time use. For example, to enter a batch of journals, the Oracle
E-Business Suite provides a Forms-based application. To submit an expense report, the
Oracle E-Business Suite provides an HTML-based application.
For Forms-based functions open the Navigator window. For more information about
the Navigator window, see Using Forms-Based Applications, page 2-1.
For more information about HTML-based applications, see Using HTML-Based
Applications, page 3-1.

Set Preferences
Select Preferences to set personal options. Options include language, territory, time
zone, notification style, accessibility setting, and formats for dates and numbers. You
can also reset your password from the Preferences page.
Optionally specify a Start Page for all future sessions from available pages (organized
by responsibility).
Note: From the Forms interface, change your Start Page using the

"Applications Start Page" profile option.

Set additional preferences using user profile options. For more information, see
Defining Preferences with User Profile Options, page 2-21.

Navigate to Frequently-Used Functions
Customize your Favorites by adding links to frequently-used functions and Web sites.
To add or remove links, select Edit Favorites.
If adding a link to a Web site, you can specify whether to open the URL in a new
window.

Getting Started with Oracle E-Business Suite
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Forms-Based Applications

Using Forms-Based Applications
The Navigator

From the Navigator you can:
•

Open forms from the Functions tab.

•

Link to documents from the Documents tab.

Forms-Based Applications
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•

Launch business processes from the Processes tab.

Open Forms
The Functions tab provides links to the forms accessible to your current responsibility.
To open a form, expand the function heading and double-click the form name.

Create a Top Ten List
Add forms that you use frequently to your Top Ten List. Create a different top ten list
for each of your responsibilities.
To add a form to the Top Ten List
•

Select the form, then select the Add to List button.

To remove a form from the Top Ten List
•

Select the form, then select the Remove from List button.

Create Links to Documents
Create links to documents that you are working on for faster access. The Documents tab
allows you to save as many links as you want. View the saved links as a list or as icons.
To add a document that is currently open
•

Choose Place on Navigator from the File menu
Important: The Place on Navigator command is not enabled for all

forms.

To rename a link that you have created
1.

Select its name (or icon) and select the Rename button.

2.

Enter the new name in the Rename Label window and click OK.

To remove a document from the Documents tab
•

Select its name (or icon) and select the Remove button.

Launch Business Processes
The Processes tab contains interactive step-by-step maps of business processes. Each
step is a form or report that you can launch directly from the process map.
Each time you launch a business process, you create an instance of that process and
assign it a name. As you complete each step in a process, the map is updated
accordingly.
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To open a process
1.

Select the process, then select the Launch button.

2.

Enter a name for the new instance.
The instance remains active until you complete or cancel it. The Processes tab lists
your active instances.

Working in a Process Instance
The active step has a box drawn around it. More than one step can be active if your
process contains multiple paths.
•

Click once on a step icon to display a description of the step.

•

Double-click on a step icon to open the related form.

•

Advance to the next step of a process from within a form by using the Next Step
toolbar icon.

The Forms Toolbar

The toolbar icons and the actions they perform are as follows:
1.

The New icon opens a new record.

2.

The Find... icon invokes the Find window.

3.

The Show Navigator icon invokes the Navigator window.

4.

The Save icon saves your data.

5.

The Next Step icon advances you to the next step of a process. See Launch Business
Processes, page 2-2.

6.

The Switch Responsibilities icon invokes the list of your responsibilities for you to
choose another.

7.

The Print... icon prints the current screen. In some cases it may print a report
associated with the current data.

Forms-Based Applications
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8.

The Close Form icon closes all windows of the current form.

9.

The Cut icon cuts the current selection to the clipboard.

10. The Copy icon copies the current selection to the clipboard.
11. The Paste icon pastes from the clipboard into the current field.
12. The Clear Record icon erases the current record from the form.
13. The Delete icon deletes the current record from the database.
14. The Edit Field... icon displays the Editor window for the current field.
15. The Zoom icon invokes customer-defined drill-down behavior.
16. The Translations... icon invokes the Translations window. See Creating

Translations for a Record, page 2-9.
17. The Attachments icon invokes the Attachments window. If attachments already

exist, the icon appears as a paperclip holding paper. See Attachments, page 2-19.
18. The Folder Tools icon invokes the Folder Tools palette window. See Customizing

the Presentation of Data, page 2-11.
19. The Window Help icon invokes online help for the current window.

Entering Data in Forms
Use the following form components to enter and query data:
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1.

Single-Row Block

2.

Multi-Row Block

3.

Folder Indicator

4.

Current Record Indicator

5.

Record

6.

Field

7.

List of Values Indicator

8.

Descriptive Flexfield

9.

Master-Detail Coordination Box.

Organization of a Form
Field
Use fields to enter, view, update, or delete information.
By default, a required field is displayed in yellow, and a read-only field is displayed in
gray. These colors can be changed or turned off using profile options. See Defining
Preferences with User Profile Options, page 2-21.

Forms-Based Applications
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In some cases, the display size of a field is too small to show the entire field contents.
Use the Edit Field toolbar icon to view and update these fields.
Record
A record is a logical grouping of fields. A record is also referred to as a row or a
transaction, since one record corresponds either to a row in a database table or to a
transaction.
You must complete all required fields in a record before moving to the next record.
Tip: If you unintentionally enter a record and cannot advance your

cursor, clear the record. From the Edit menu, choose Clear, then Record
.

Block
A block displays a set of records either in a single-row format or a multi-row format.
Tip: To clear data at the block level: From the Edit menu, choose Clear,

then Block.

Creating and Deleting Records
To create a record
1.

Choose New from the File menu, or use the New toolbar icon.

2.

After entering data for your new record, choose Save or Save and Proceed from the
File menu to save the record to the database. Choosing Save and Proceed
automatically advances you to the next record.

To delete a record
1.

Choose Delete from the Edit menu.
This action erases the current record from your screen, and returns your cursor to
the first field of the next record.

2.

To delete the record from the database, choose Save or Save and Proceed from the
File menu.

Using a List of Values (LOV)
A field that has a predefined list of valid values displays an LOV icon. Select this icon to
view the valid field values.
If a list contains more than 100 values, you are prompted to enter a Find string to limit
the list.
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To choose a value from a list
Select a value, or reduce the list using one of the following methods:
•

Without placing your cursor in the Find field, type the initial character(s) of a value
to autoreduce the list to those items matching the characters entered. Use the
Backspace key to re-expand the list. If your entry reduces the list to a single value,
the list window closes and inserts the value into the field.
Note: Lists that require a Find string do not use the autoreduce

feature.

•

In the list window, enter any group of characters in the Find field and select the
Find button.
Note: Use the wildcard character (%) to represent any number of

characters, and the underline (_) to represent a single character. Do
not enter a wildcard character by itself. This will match all records.

Power List
Power List enables you to enter a search string or partial value in an LOV field without
opening the list window.
To use Power List
Enter the initial characters of a value in the field and press the Tab key. Power List
completes the entry for you.
Your entry can include wildcard characters.
If more than one value matches the characters you specify, a list window opens
containing those values.

Advanced Data Entry Features
Master-Detail Relations
A Master-Detail relation is an association between two records. An example is the
relationship between the Batch and Journals records in Oracle General Ledger. Each
batch (master record) is associated with a set of journal entries (detail records).
Some master-detail blocks contain a coordination check box that allows you to choose
whether detail records are queried. Select the master-detail coordination check box to
automatically coordinate the update of records between the master and detail blocks. If
you deselect the check box, the detail data is not displayed until you move your cursor
into the detail block.

Forms-Based Applications
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Drill-Down Indicators
Some records provide additional details in separate, drill-down windows.
A wide-width current record indicator designates that a record provides drill-down
information. Double-click the indicator to open the detail window.
Flexfields
A flexfield is a flexible data field that can be customized by your enterprise. Oracle
E-Business Suite uses two types of flexfields:
•

Key flexfield - a field you customize to enter multi-segment values, such as part
numbers or account numbers.

•

Descriptive flexfield - a field you customize to enter additional information not
provided by Oracle E-Business Suite.

Key Flexfields

A key flexfield is composed of segments, where each segment has both a value and a
meaning. For example, an Accounting Flexfield can be composed of segments that
represent Company, Department, and Account. The segments are delimited by a
segment separator (usually a "." or a "-").
A range flexfield is a type of key flexfield in which you can input a low and a high value
for each segment to express a range of combinations.
A key flexfield looks like any other field. You can enter the segments directly or use the
Flexfield window to enter each segment separately.
To enter data directly into a key flexfield
•

Enter the segment values, separating each with the segment separator.

To enter data using the flexfield window
1.

Select the List of Values icon to open the flexfield window, or select the Edit Field...
toolbar icon.

2.

Enter a value for each segment, or use the list of values where available.

3.

Select the Combinations button in the flexfield window to search the list of existing
segment combinations.

To enter data in a range flexfield
•

Enter a Low and a High value for each segment, or use the list of values where
available.

Descriptive Flexfields

A descriptive flexfield appears as a two-character, unnamed field enclosed in brackets.
Move your cursor into the bracketed field to open the descriptive flexfield window. The
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window contains segments that make up the descriptive flexfield. Each segment can
have a list of values.
To enter data in a descriptive flexfield
1.

Open the descriptive flexfield window. If your profile option Flexfields:Open Descr
Window is set to "No", or if you are in a folder, select the Edit Field... toolbar icon to
open the flexfield window.
Note: For more information on profile options, see Defining

Preferences with Personal Profile Options, page 2-21.

2.

Enter a value for each segment, or use the list of values where available. Default
values can be overwritten.

Creating Translations for a Record
Windows that allow the entry of records in multiple languages display the enabled
Translations... toolbar icon.
To enter a translation for a record
1.

Select the record you wish to translate.

2.

Select the Translations... icon from the toolbar.
The Translations window opens, with translatable fields displayed in columns. The
installed languages are displayed in rows.

3.

Enter translations for the displayed fields.

Using Keyboard Help
Use keystroke combinations to perform many menu functions.
To view the list of functions and keystroke combinations
•

Choose Keyboard Help... from the Help menu.

Searching for Data
To query records in your current block or window, use the Find command or Query by
Example.

The Find Command
The Find command displays a window in which you can specify search criteria.
Depending on the block that you invoke Find from, one of two types of windows
appears:

Forms-Based Applications
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•

A find window that contains fields for entering search criteria.

•

A list window that shows all possible records that you can retrieve for the block.

Generally, a find window appears for a multi-record block, while a list window appears
for a single-record block.
Using the Find Command
•

Choose Find... from the View menu or select the Find toolbar icon.
•

If a list window appears:
•

•

Use a list window as you would an LOV window. See Using a List of
Values (LOV), page 2-6.

If a find window appears:
1.

Enter as many search criteria as you can.

2.

Select the Find button.

Query by Example
To retrieve a group of records based on more sophisticated search criteria than Find
allows, use Query by Example. Query by Example allows you to specify search criteria
in any of the queryable fields in the current block. The search criteria can include
specific values, phrases containing wildcard characters, or query operators.
If you do not need to retrieve the records, but only want to know how many records
match your search criteria, perform a query count.
Using Query by Example
1.

From the View menu, choose Query by Example, then Enter.
This action switches your window from data entry mode to Enter Query mode.
Queryable fields are displayed in blue.

2.

Enter search criteria in the queryable fields. (Fields may be case-sensitive). To reuse
criteria from your last search: From the View menu, choose Query by Example,
then Show Last Criteria.
Important: In Enter Query mode, all check boxes are initially in a

null state. To use a check box as a search criterion, you must
explicitly check or uncheck it.

3.
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4.

To exit Enter Query mode without searching: From the View menu, choose Query
by Example, then Cancel.

To perform a query count
1.

Perform steps 1 and 2 from the previous task: "To use Query by Example".

2.

From the View menu, choose Query by Example, then Count Matching Records.
The window's message line displays the number of matching records.

Query Operators
The following table shows the query operators for most fields, their meanings, and an
example expression:
Query Operators
Operator

Meaning

Example Expression

=

equals

= 'Janet', = 107

!=

is not

!= 'Bob', != 109

>

greater than

> 99.1, > '01-JAN-04'

>=

at least

>= 55

<

less than

< 1000.00

<=

at most

<= 100

#BETWEEN

between two values

#BETWEEN 1 AND 1000

Customizing the Presentation of Data
Folder blocks allow you to personalize a form. You can define a query, customize the
layout of the form columns, and then save the query and layout in a folder definition
that can be retrieved later.
Folder blocks display an Open Folder button. When you move the cursor into a folder
block, you enable the Folder Tools toolbar icon and the Folder menu.
Important: If your system administrator sets the profile option Folders:

Allow Customization to "No", you cannot create or customize folders.

Forms-Based Applications
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The only item available from the Folder menu is Open, to open a
predefined folder. For more information about profile options, see
Defining Preferences with User Profile Options, page 2-21.

Query Criteria for a Folder
To define query criteria for a folder
1.

Run a query, either by using the Find command or Query By Example.

2.

Save your query criteria by choosing Save As from the Folder menu.

3.

Enter a name for the folder.

4.

Select Always, Never, or Ask Each Time from the Autoquery option group to
define how frequently to perform the saved query.

5.

Select the Open as Default check box to set this folder definition as the default
every time you navigate to this form.

6.

Select the Public check box to allow other users to access your folder definition.
Selecting Public does not enable other users to modify your folder.

7.

Select the Include Query check box to include your query in the folder definition. If
you do not select this check box, only the folder layout is saved.

To view the query criteria for a folder
•

Choose View Query from the Folder menu.
The Folder Query window displays the query used to retrieve the records
displayed in the folder. An empty window indicates that the folder retrieves all
records.

To reset the query criteria for a folder
1.

Choose Reset Query from the Folder menu.
This clears the query from the current folder, but retains the current folder name
and field layout.

2.

Perform another query and choose Save from the Folder menu to save the new
query to your current folder.

Customizing the Layout of a Folder
Use the Folder menu or the Folder Tools window to customize the folder layout. Some
layout changes can be made using the mouse. For example:
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•

Change the width of a column by dragging the column's border.

•

Change the sequence of a column by dragging the column's heading to a new
position.

•

Change the name of a column by using the right mouse button on the column's
heading. A window prompts you for the new name.

To access the Folder Tools window
•

Select the Folder Tools toolbar icon, or choose Folder Tools from the Folder menu.

Running Reports and Programs
A report or a concurrent program can be scheduled and submitted as a single request,
or you can schedule and submit multiple reports and programs together as a request
set.
Important: The navigation path you use to schedule and submit

requests varies by application. Some of the options mentioned may not
be available based on the selected request or your responsibility. Some
functions automatically submit a request when you choose a specific
button or save your work.

Request Submission
1.

Choose the Program Name from the list of available requests and then enter a
Request Name, which can be used later to search and monitor your request.
Use the Copy... option to choose and submit a request that you have previously
submitted from this responsibility.

2.

Define parameters.
If a request requires parameter values, the Parameters window opens. Enter the
values in the required parameter fields.
Note: Your user profile option Flexfields:Open Descr Window must

be set to "Yes". See Defining Preferences with User Profile Options,
page 2-21.

3.

Determine the output language.
If your site supports multiple languages, select the language for your request
output.
Choose the Language Settings... button to open the Languages window. If the
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language selection is predefined in the report, the Language Settings... button is not
enabled.
In the Languages window select the Language, Territory, and Numeric Character
settings appropriate for your report.
Select the Select All button to produce output in all languages supported at your
site or to check individual languages.
Important: Each language creates its own request, so the number of

languages determines the number of requests created and tracked
in the Requests window.

4.

Define a schedule.
Specify when you would like your request to run. You can choose a simple
schedule such as, as soon as possible, a specific date and time, or recurring intervals; or
you can choose a more advanced schedule such as specific days of the week or specific
dates in a month. You can also choose a previously saved schedule.
Note: If you do not select an end date for the more advanced

schedules, the request will continue to run until it is cancelled.

5.

Define the layout.
•

Template Name - If the request has multiple layout templates available, you
can select a different template to apply to the request.
If you selected multiple language outputs from the Languages window, a
separate template entry displays for each language. You can apply a different
template for each language.

•

Template Language – This field defaults to the language selected for the
request. If the template is not available for a selected language, this field
defaults to the session language.

•

Format – The output format selection varies by template. Some options are
PDF, RTF, and HTML.

•

Preview - If sample data is available for the request, select the Preview button
to display the selected template with the sample data.
Note: Select the Options... button to change the default layout.

notification, and output options.

6.
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Choose the employee name from the list of available employees, and then choose
the circumstance of when to notify this employee. This option sends an E-mail
notification, with a link to the request, based on if the request ran normally or
resulted in a warning or error.
7.

Print the output to:
For printed output, select the print style, printer, copies, and language.
To view your output online or to save your output to a file, select the Save all
Output Files check box.
Note: Some requests have a required Style, Printer, or Language

value that you cannot change.

8.

Specify delivery options for Internet Printing Protocol (IPP) printer, E-mail, Fax, or
FTP.

9.

Review your choices, make any necessary changes, and submit your request.

Multiple Organizations Reporting
Multiple organizations reporting improves reporting capabilities of Oracle E-Business
Suite by allowing reporting across operating units.
An operating unit is an organization that uses Oracle Cash Management, Order
Management and Shipping Execution, Oracle Payables, Oracle Purchasing, and Oracle
Receivables. An operating unit is associated with a legal entity and may be a sales office,
a division, or a department. Information is secured by operating unit for these
applications, and you see information only for your operating unit.
When multiple organizations reporting is active, a list of available operating units is
enabled when you enter the Program Name. Choose the operating unit to run your
report against and continue submitting your request.

Request Sets
1.

Choose the Request Set Name from the list of available request sets.
Use the Copy... option to choose and submit a request set that you have previously
submitted from this responsibility.

2.

Define the parameters, layout, notification, and printer output information for each
report or program listed in the request set.

3.

Define the schedule.
Specify when you would like this request set to run. See Request Submission, page
2-13.
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4.

Review your choices, make any necessary changes, and submit your request set.
Note: Each report or program contained in the request set is

assigned its own ID so that its status can be monitored individually
on the Requests page.

Monitoring Requests
The Requests window allows you to:
•

View the status of your submitted requests.

•

Change processing options.

•

Diagnose errors.

•

View your request output.
Important: You can view only those requests to which you have been

granted access by an administrator.

Request Phase and Status
A request has a life cycle consisting of the following phases: pending, running, and
completed. If a request is on hold or unable to run, the request is placed in an inactive
phase.
During each phase, a request has a specific status. Listed below are the possible statuses
for each phase:
•

Pending Phase - Normal, Standby, Scheduled, Waiting

•

Running Phase - Normal, Paused, Resuming, Terminating

•

Completed Phase - Normal, Error, Warning, Cancelled, Terminated

•

Inactive Phase - Disabled, On Hold, No Manager

For more information about the status of your request, select the Diagnostics button in
the Requests window.

Finding Requests
1.

Open the Requests window (navigation varies by application).
When you open the Requests window, you are directed to the Find Requests
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window.
2.

Define your search criteria.
Note: You can use the Specific Requests region to view a list of

requests that you did not submit by entering a requestor other than
yourself. However, you can only view details, output, and log files
for requests submitted by you or your responsibility.

3.

Select Find.

Options for Requests in Progress
Hold or cancel pending requests from the Requests window using the Hold Request or
Cancel Request buttons.
View request diagnostics by selecting the Diagnostics button. The Request Diagnostics
window displays information about the request run. The window may contain a View
XML button to display the generated XML data, if applicable.
You can change completion and scheduling options for requests that meet the following
criteria:
•

You made the initial request.

•

The request has not yet run.

•

The program does not prevent request updates.

To Change Options for a Request in Progress
1.

Select the request from the list.

2.

Select the View Details... button to launch the Request Detail window.
•

To update a request's schedule, select the Schedule... button.

•

To update a request's completion options, select the Options... button from the
Upon Completion... region.

Viewing Request Output
Reports are displayed in a browser, in the Report Viewer, or in another application
registered by your system administrator. Reports that produce an output other than a
text file, such as HTML or PDF, are displayed in a browser.
Set the profile option Viewer: Text to "Browser" to display your text files in a browser. If
your system administrator registered other applications for viewing reports, select your
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text viewer application using the profile option Viewer: Application for Text. If this profile
option is not set, you get a choice of applications when you view the report.
For more information about these profile options, see Defining Preferences with User
Profile Options, page 2-21.
To View Request Output
1.

Navigate to the Requests window.

2.

Select the completed request and select the View Output button.
Tip: To view request log files: Select the View Log button.

To save request output displayed in the Report Viewer
1.

Choose Copy File... from the Tools menu to display the Viewer Option window.

2.

Select an output file format. This action opens your browser window.

3.

From the browser window, use your browser's tools to save your request output to
a file.

Republishing or Reprinting Requests
Requests with multiple layout templates can be republished using a different template.
If multiple templates are not available, reprint is the only option.
1.

Select the request and choose the Republish button or choose Republish... from the
Tools menu.

2.

In the Republish and Reprint Request window, choose one of the following:
Republish & Print - Allows you to select a new layout template, language, and
output format for the data already generated by your request, and print the output.
Republish & View - Allows you to select a new layout template, language, and
output format for the data already generated by your request and simply view the
output online.
Reprint existing output - Reprints the request.

3.

Choose the Layout and Printer options as appropriate for your selection.

Saving Reports from Your Browser
You can use the Save As functionality of your browser to save an HTML report to your
desktop. Ask your system administrator for assistance if your browser does not display
your language's character set clearly.
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Exporting Records to a File
Use the export feature to save the records in a multi-row block to a tab-delimited file.
Open the file in the application of your choice.
To start an export
1.

Query the records you want to export.

2.

Place your cursor in the multi-row block that contains the records to be exported.

3.

Choose Export... from the File menu.

Exporting Large Numbers of Records
Export, by default, selects all the records retrieved by the query. If the number of
records exceeds 100, you are prompted to:
Stop - Limit the export to those records you have explicitly selected. Alternatively,
cancel the export.
Continue to End - Export all records retrieved by the query.
Important: Avoid exporting a very large number of records as system

performance can be affected.

Continue - Select the next 100 records for export. You are prompted every 100 records
until all records are selected, or you choose Stop or Continue to End.

Attachments
Use the Attachments feature to link text or other files to a record.
The Attachments... toolbar icon is enabled when the attachments feature is available. If
the current record already has an attachment, the icon appears to hold a piece of paper.
To open the Attachments window
•

Click the toolbar icon or choose Attachments... from the View menu.

To add a new attachment
1.

Select a Category from the list of values. The Category defines the purpose of an
attachment and controls which forms or pages can access it.

2.

Select the attachment Data Type from the list of values:
•

Text - Enter text that is less than 2000 characters. If the text you want to attach is
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more than 2000 characters, upload it in a file.
•

File - Launch the Upload a File window in your browser. Select the Browse
button to locate the file in your file system or enter the file location in the File
field.

•

Web Page - Your cursor advances to the URL field on the Source tab of the
window. Enter the URL for the Web page.

3.

Optionally add a title for your document.

4.

Select the May Be Changed check box to allow changes to the attachment.

To attach a document from the Document Catalog
1.

Choose the Document Catalog... button to open the Document Catalog window.

2.

Use the Find Existing Documents region to query existing documents. Matching
documents are returned in the Documents region.
Note: To copy an attachment from another record, use the Attached

To: field to select the application object you want to copy
attachments from.

3.

To view a document before attaching it, select it and then choose the Preview
button.

4.

Select the document(s) to attach.

5.

Choose the Attach (n) button, where n is the number of documents selected.

To view an attached document
In the Attachments window, select the attachment you want to view. If the attachment
does not automatically display in the document block, select the Open Document
button to view the document in a browser.
To delete a record's attachment
When you delete an attachment, you can remove the association between the record
and the attached document or remove the attached document from the file system or
database.
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1.

In the Attachments window, select the document to delete.

2.

Choose Delete from the Edit menu.

3.

Select a button in the Decision window to remove either the Document and
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Attachment or just the Attachment.

Defining Preferences with User Profile Options
Use profile options to modify the way your applications run.
Oracle E-Business Suite supports a set of user profile options that are common to all
applications. In addition, each application has its own set of user profile options. See
your application's documentation for information on application-specific profile
options.

Profile Hierarchy
Profile options can be set at four levels:
•

Site - affects all applications installed at a site.

•

Application - affects a specific application.

•

Responsibility - affects the applications assigned to a specific responsibility.

•

User - affects the applications run by a specific user.

A User-level setting overrides a Responsibility-level setting, which overrides an
Application-level setting, which overrides a Site-level setting.
Your system administrator sets options at all four levels. You can change options only
at the User level.

Setting Profile Options
Use the Profile Values window to display and change your user profile options.
Note: There are some profile options that you can view but not change.

For example, you can view the value for Concurrent:Request Priority,
which is set at the User level, but only your system administrator can
change its value.

If you do not set a user profile option, it assumes a default value set either by your
system or your system administrator.
To set a profile option
1.

Navigate to the Profile Values window (navigation varies by application.)
•

To view a specific profile, use Find or Query by Example.
The Profile Values window displays the Profile Name, Default Value, and
User Value.
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2.

Enter a value in the User Value field or choose a value from the list of values, if
available. To accept the default setting, clear the User Value field.
Important: Number and date values are not validated. Ensure that

you enter a valid number or date, or the associated profile option
may not work as you expect.

3.

Choose Save from the File menu or select the Save toolbar icon.
Note: Some profile option changes do not take effect until you

change responsibilities or restart your session.

Common Profile Options
Flexfields:Open Descr Window
Controls whether a descriptive flexfield window automatically opens when you
navigate to it. Valid values are Yes or No.
FND: Indicator Colors
Valid values are Yes (default), No, or null. When this profile option is set to Yes:
•

Required fields are displayed in yellow.

•

Queryable fields are displayed in a different color while in enter-query mode.

•

Read-only fields are rendered in dark gray.

Folders:Allow Customization
Determines whether you can personalize folders. Valid values are:
•

Yes - you can create or customize folder definitions.

•

No - you can open only existing folder definitions.
Note: Only the system administrator can update this profile option.

Indicate Attachments
Turns off the indication of attachments when querying records (for performance).
Note: Only the system administrator can update this option.
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Printer
Use this option to define your printer.
Sign-On:Notification
Valid values are Yes and No. Yes displays a message at login that indicates:
•

If any concurrent requests failed since your last session.

•

How many times an incorrect password was used with your username since you
last logged on.

•

If the default printer identified in your user profile is unregistered or not specified.

Viewer: Application for Text
If your system administrator has registered other applications for viewing text output,
select the application from the list of values. The profile option Viewer: Text must be set
to Browser to use this profile option.
Viewer: Text
Sets the display viewer for text report output. Valid values are Browser and Report
Viewer.
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3
HTML-Based Applications

Using HTML-Based Applications
HTML-based applications use the following common components:

1.

Process Train

2.

Date Picker

3.

Global Links
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4.

List of Values Icon

Navigating
Navigate to functions in an HTML-based application using tabs, subtabs, and side
navigation elements. As you drill down through these elements, locator links display
your navigation path.
When you navigate through records in a table, use the Previous and Next links. When
you navigate through steps of a task, use the Back and Next buttons.
Important: Use these forward and backward navigation elements

provided by the application. Do not use your browser's buttons.
Process Train

If you are executing a process, a process train shows the location of the current page in
the process. Some process trains are interactive. These allow you to jump one or more
steps backward in the process by selecting the step icon.
Locator Links

Locator links (sometimes called "breadcrumbs") are series of links and text that show
your navigation path through an application. Use the links to return to a previous point
in your navigation path.
Navigator and Favorites Menus

The Navigator and Favorites menus appear as links on every HTML page.
Use "Manage Navigator" to hide or show entries in this list.
Use "Manage Favorites" add or remove entries in this list. Use "Add to Favorites" to add
the current page to the Favorites list.
Note: This feature must be enabled by your system administrator

through a profile option.

Using Oracle E-Business Suite Secure Enterprise Search
By leveraging Oracle Secure Enterprise Search (SES), Oracle E-Business Suite Secure
Enterprise Search provides a centralized search capability allowing you to use text
search on applications content without compromising on the security and context
sensitive information.
Through a secure text search, not only can you enjoy the immediate search results with
accuracy, but you can also easily refine the search by narrowing down the results or
tracing back to original results in an efficient way.
Note: Oracle E-Business Suite Secure Enterprise Search does not replace
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all the Search pages, instead it is deployed where it makes the most
sense in searching for applications content. See Querying and Viewing
Data, page 3-9 for other search pages.
For more information on administering Oracle E-Business Suite Secure
Enterprise Search, see the Oracle E-Business Suite System Administrator's
Guide - Maintenance.

From the Oracle E-Business Suite Secure Enterprise Search region embedded in your
application, you can:
1.

Perform a search in the Search region.

2.

View your search results in classic or tabular format.

3.

Narrow down your search results using the Narrow By region.

4.

Roll back to your previous search results using the Expand By region.

5.

Enter filters in the Filter region to narrow down the search results on a searchable
object only.

HTML-Based Applications
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Using the Search Region
The Search region appears on top of the Oracle E-Business Suite Home page or your
product home page.
To perform a search using the Search region
1.

Select a searchable business category from the LOV.
To secure the application data to only those who have the access privileges, Oracle
E-Business Suite Secure Enterprise Search only displays the searchable categories in
the LOV that you have been authorized for access.
For example, if you are authorized to access 'Customer Relation' business category,
you should find 'Customer Relation' from the LOV.
Note: If "All" business category is selected, then you will not find

search results for objects that require security based on full security
context privileges such as "Vacancies" object in iRecruitment. This
is because "All" category search is designed to give results for
objects with normal security (or not based on full security context)
only. Instead, you will need to search on the group (such as
"Vacancies") or narrow down to the object to get results if you have
the access privileges.

If the 'Customer Relation' business category contains Contracts and Customer
Account business objects, after executing a search on 'Customer Relation' category,
you will find these two business objects displayed in a tree structure in the Narrow
By region. See: Narrowing Down the Search Results Using Narrow By, page 3-8.
2.

Enter a keyword search or enter partial values containing wildcard characters
(regular expressions wildcard '*', not '%') on the selected category.
Note: Because date based columns are precrawled and indexed in

the form of YYYY-MM-SS, if you want to base search on a date
value, use the same format 'YYYY-MM-SS' as the query string. For
example, use '2007-04-25' to search for records dated on
25-Apr-2007.

The search text entered here is also recorded in the Expand By region. See: Tracing
Back the Results Using Expand By, page 3-8.
3.

Select your Search Results Display Preference value from the following drop-down
selection options.
•
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Oracle E-Business Suite User's Guide

See: Viewing the Search Results in Oracle E-Business Suite, page 3-5
•

Advanced: If 'Advanced' is selected, without logging out from Oracle
E-Business Suite, the results will be displayed and rendered directly in the
Oracle SES user interface if Single Sign On has been configured and the search
results page in Oracle SES has been customized with your desired result
display.
See: Viewing the Search Results in Oracle SES, page 3-7

Click Go to execute your search and have the results displayed based on your
selected display value.

Viewing the Search Results
Oracle E-Business Suite Secure Enterprise Search provides a flexible search result
display mechanism allowing you to view the results either within the Oracle E-Business
Suite or directly from the Oracle SES user interface based on your selected search results
display value.
Viewing the Search Results in Oracle E-Business Suite
By default, 'Standard' Oracle E-Business Suite is the default value in the Search Results
Display Preference field. This lets you view the search results in the Results region
within the Oracle E-Business Suite.
The search result details include the last crawled time for your selected search object or
group, current page number and results displayed, total number of estimated hits, time
taken by search engine in performing the search, and the search results for each
element.
Note: The total number of estimated hits is just a rough estimate. To

have a more accurate estimate, Oracle SES allows administrators to set
a parameter in global setting to report an exact count of search results.
However, this option impacts query response time. See Oracle Secure
Enterprise Search Administrator's Guide for details.

Each search result page contains a list of result elements that match the search criteria.
The result can be displayed in the following different formats:
•

Classic Style: All result elements are displayed in the classic style if the search is on
a searchable category.

•

Tabular Style: If a search is on a searchable object selected in the Narrow By region,
the Result Style drop-down field appears letting you change the display from the
default classic style to tabular format. The tabular style displays the search results
in a table or spreadsheet like format, while the classic style displays the results in an
Internet like format.
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To easily navigate to each result element contained in the page and make the search
result more user-friendly, the following information can be shown as part of the result
display for each element:
•

Relevance Ranking: A percentage value (or called 'Score') is displayed in a
parenthesis as part of the result element title link indicating the relevance of the
result element is to your search criteria. For example, a result element with a score
value of 78 percentage indicating a high relevance to the search criteria compared to
an element with a score value of 40 percentage. A result element with the greater
percentage value will be shown higher in the result list.
Click the title link of a result element lets you drill down the element details. For
example, click on a job title 'Accounting Manager' (with a score or relevance
percentage value) link to view the Accounting Manager job details.

•

Score: It describes the source object name to which searchable object that each result
element belongs.
This feature is particularly useful if a searchable group has multiple searchable
objects or in case of "All" category search. This helps you easily identify the source
of hit.

If the result is displayed in the classic style, you might find the following links available
(if these attributes are identified and associated with the object you search on):
•

Actionable Links: This lets you visit external URLs.

•

Related Search: If a relation exists between the object searched on and other objects.
This lets you perform a search on related object.
The related search content is secured by authorization. Only users with appropriate
access privileges can execute search on the related objects. Otherwise, an
unauthorized access message appears indicating that you do not have the access
privileges.
For example, 'Customer Invoices' might be displayed as a related object while
searching for 'Customer Relation'. Clicking on the 'Customer Invoices' object link
will execute another search on the related object only if you have the access
privileges. Otherwise, an unauthorized access message appears.
Note: For better query time performance, the search result will

display related objects along with other search hits even though
you do not have the access privileges to some of the objects.

Sorting Search Results

To have the search results displayed in your desired order, Oracle E-Business Suite
Secure Enterprise Search provides the sorting option allowing you to sort the entire set
of search results based on your selected value from the Sort By drop-down list.
The drop-down list will be available in both classic and tabular display format. The
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sorting criteria in the drop-down list will contain all the displayed attributes on which
the sorting can be performed. Initially, the result will be sorted in ascending order. You
can optionally change the sorting order by clicking on the Down Arrow icon next to the
Sort By drop-down list to sort the result in descending order.
Exporting Tabular-based Search Results

If a search result is displayed in the tabular format, the Export button is available in the
search results region. Clicking the Export button lets you export the tabular-based
search result content directly from the search results region to Microsoft Excel. You can
save the exported data to a designated directory to use later.
Note: The program that is launched while saving exported data is

dependent on your computer setting. To launch a .csv file in
Microsoft Excel, the .csv file type needs to be mapped to open with
Microsoft Excel. If it is not mapped, Microsoft Windows will ask you to
choose a program with which to open the file.
This export feature is only available for the search results displayed in
the tabular format, but not for the classic display.

The exported data can be served as an offline report which is particularly useful in
several business functions.
For example, you can search inventory items by part number, specification, lot number,
location or by stock levels or any other indicator as needed. After the search, you can
export the results to Microsoft Excel and use the data for reconciliation with physical
inventory. Additionally, you can search for any outstanding invoices for a particular
customer by giving a date range (age bracket). Export the search results displayed in the
tabular format and then perform offline activities such as reconciliation of accounts or
following up with the customers on the invoices.
Viewing the Search Results in Oracle SES
Instead of rendering the search results region within Oracle E-Business Suite, you can
view the search results directly in Oracle SES user interface if 'Advanced' is selected as
the Search Results Display Preference value.
Oracle SES UI provides rich functionality in searching and grouping as well as the
flexibility to customize the search results display for various business needs. This
feature allows you to directly invoke and view the search results in Oracle SES UI
without logging out from Oracle E-Business Suite if the Single Sign On has been
configured and you have the search results page in Oracle SES UI customized with your
desired result display.
If you want to refine your search, click the Advanced Search link to open the Advanced
Search page where you can enter more search criteria or attributes for your search.
How to perform search in Oracle SES user interface and customize the search results,
see Oracle Secure Enterprise Search Administrator's Guide.
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Narrowing Down the Search Results Using Narrow By
Use the Narrow By region to narrow down the search results by selecting the following
search components from a tree:
•

Searchable Group
A business category is comprised of searchable groups and objects. A searchable
group is preceded with the "check" icon when displayed in the tree. By selecting a
searchable group link from the tree, all other searchable groups or objects contained
in the selected group are displayed as a child node. If you select a searchable group
from the child node, the selected group becomes a parent node in the tree, and the
selected group name is added to the Expand By region allowing you to trace back
the original search result. If a selected child node is a searchable object, then this
object becomes a parent node and all the fields underneath become a child node.
Note that if a search is on a searchable group, the result is displayed in classic
format only, and the Result Style field is not visible.

•

Searchable Object
A searchable object node is preceded with the "object" icon in the tree. When
refining your search on a searchable object, the selected object name becomes a
parent node in the tree, and all the fields underneath become a child node. These
field-based child nodes allow you to further narrow down the search results by
applying filters. See: Using Filters on Searchable Objects, page 3-8.

Tracing Back the Results Using Expand By
Use the Expand By region to roll back to the original search result after you modify the
search in the Narrow By region. The Expand By region displays all the search criteria
you used for a search including the text entered in the Search region, group names,
object names, or any filters. Clicking on any links in the Expand By region will bring the
result back to the point from where you came. For example, clicking on the 'Oracle'
filter link removes the filter from a search and expands the search result without being
restricted by the filter, 'Oracle'.

Using Filters on Searchable Objects
Use the Filter region to narrow down your search on a selected object. When you select
a searchable object in the Narrow By region, the Filter region appears allowing you to
apply filters on the selected object. By entering filter text and clicking Search With
Filter, a search with filter criteria is executed.
Note: To search on an exact phrase through filters, use quotation marks

(") around the phrase. For example, enter "contract imported" as the
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filter text to find the exact phrase from the search result. Without the
quotation marks, you will find either 'contract' or 'imported' from the
result.
Please note that filters do not consider words "to", "the" and "other". If
any of those words are entered as filter text, you will find that search
results not containing above values are also displayed. This is because
those words are considered as stopwords in Oracle SES. Hence, they
are removed from queries.

See: Narrowing Down the Search Results Using Narrow By, page 3-8.

Querying and Viewing Data
Pages that allow you to search for data display a Search panel that generally includes a
search region and a results region. Many search panels contain an Advanced Search
button that allows more detailed searches using additional criteria.
When you enter characters in a search field, a wildcard is implicitly added to the end of
the string.
The results region displays search results in a table. Columns that are sortable have a
highlighted heading. The currently-sorted column displays an arrow icon to indicate
whether the sort is ascending or descending.
Click the column heading of a sortable column to sort by that column. Click it again to
toggle between ascending and descending order.
Many pages allow you to save searches and personalize the display tables. See
Personalizations, page 3-14.

Using a Hierarchical Grid (HGrid)

1.

Locator links define the position of the displayed grid in the navigation hierarchy.
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2.

Use the Hide/Show icon to expand and collapse the branches of the tree.

3.

Use the Focus icon to display only a specific branch in the tree.

Using Pop-up Windows
Pop-up windows provide additional information on top of the current page. They
appear when you hover over an item or click on it with the left mouse button. Pop-up
windows are available on some components of these types:
•

Text

•

Image

•

Link

•

Button
Note: This feature must be enabled by your system administrator

through a profile option.

Entering Data
Entering Data in a List of Values (LOV) Field
If you know the value for a field, enter it and press the Tab key. If you know the
beginning of the value, begin typing in characters into the LOV field and matching
values will be displayed inline (look-ahead capability). Choose your desired value or
wait for the Search and Select page to launch.
Navigate the look-ahead poplist using:
•

Tab - Highlights the next record.

•

Up Arrow - Highlights the previous record.

•

Down Arrow - Highlights the first record if no records are currently highlighted, or
highlights the next record if a record is already highlighted.

•

Left-click with mouse - Selects the highlighted record as the value for the LOV field.

•

Escape - Dismisses the look ahead poplist without selecting a record.
Note: The look-ahead capability must be enabled by your system

administrator through a profile option.

3-10

Oracle E-Business Suite User's Guide

If you do not know the value, choose the List of Values icon to launch the Search and
Select page. Entering a partial value before launching the Search and Select page limits
the results. If the partial value matches only a single value, the field autofills and the
Search and Select page does not launch.
Some Search and Select pages support alternate search criteria. Use the Search by
pulldown list to select a different search field. Enter the search string and select the Go
button. Select the value from the Results region and choose the Select button.

LOV Choice List
When a field has a long list of possible values from which a small subset is commonly
used, you may see an LOV choice list. The LOV choice list displays the most
commonly-used values for easier selection and includes a More... option. Choosing
More... launches the LOV Search and Select page.
When you choose a value that is not in the LOV choice list, it is added to the list.

Personalizing an LOV Choice List
An LOV choice list may allow you to customize the list with the values that you use
most frequently.
To personalize an LOV choice list
1.

Select the Personalize button next to the LOV choice list to open the Personalize
page.

2.

To add a value, select it and choose the Add button.

3.

To delete a value, select the icon in the Delete column.
Note: Some values cannot be deleted.

4.

To reorder the list, select the Reorder button. In the Reorder page, select a value
you want to move and use the Move icons to position it in the list. When finished,
select the Apply button.

Entering Dates
Enter a date directly in a field using the format defined in your Preferences.
Alternatively, select the calendar icon to launch the Date Picker pop-up window. When
you select a date, the window closes and inserts the date into the field.

Using Hot Keys
The following hot keys are supported in HTML-based applications. To perform the
action, press the Alt key + the key listed in the table:
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Action

Key

Apply

p

Back

k

Cancel

l

Continue

c

Finish

i

Next

x

No

n

Save

s

Search

r

Submit

m

Yes

y

Right Subtab

>

Left Subtab

<

Scheduling Requests and Request Sets
For information on how to schedule a request or request set, see Running Reports and
Programs, page 2-13.

Monitoring Requests
The Monitor Requests pages provide a summary of requests and details of each
request.
Select the Search button to specify your search criteria.
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Related Topics
Monitoring Requests in Forms-Based Applications, page 2-16

Using Attachments
Use the Attachments feature to link text or other files to a record.
If the Attachments feature is available, the page will display either the Attachment List
link or the Attachments icon.
The method to initiate an Attachments flow will vary, depending on how the feature is
implemented on your page.
To add a new attachment
1.

Display the Add Attachments page.

2.

Using the Add poplist, select how you want to add the attachment:
From a Desktop File/Text/URL
1.

Select a Category from the list of values. The Category defines the purpose of
an attachment, and controls which forms or pages can access it.

2.

Select the attachment Type:
•

File - Specify a file name to upload. Enter the file location, or use the
Browse button to locate the file.

•

URL - Enter the URL for a Web page.

•

Text - Enter text that is less than 2000 characters. If the text you want to
attach is more than 2000 characters, upload it in a file.

From the Document Catalog
1.

Use the Search regions to query existing documents.

2.

Select the Document Name link to view a document before attaching it.

3.

Select the document(s) to attach.

4.

Select the Apply button.

Save your work in the application page from which you launched the attachments flow.
The attachments are not added until you save your work in the parent region.
To view an attached document
In the Attachments page or Attachments table, select the File Name link.
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•

If the attachment is a URL, the Web page will launch.

•

If the attachment is a file, a dialog box prompts you to open or save the file.

•

If the attachment is text, the View Attachment page displays the text content.

To edit an attachment
1.

Display the Attachments page or Attachments table.

2.

Select the Update icon.

3.

In the Update Attachment page, edit only the information as it pertains to the
attachment. For example, you can update the URL for a Web page attachment, but
you cannot change it to a File attachment.

4.

Select the Apply button.

5.

Return to the application page from which you launched the attachments flow and
save your work.
Tip: Attachment updates must be saved in the associated parent

region.

To delete a record's attachment
In the Attachments page or Attachments table, select the Delete icon.

Inline Attachments
With the inline attachments feature, if you hover over the Add icon or the Attachments
icon, an inline window appears and allows you to add or view attachments without
navigating to the separate Attachments page. Text attachments can be edited inline.
Note: The inline attachments feature is enabled by your system

administrator through a profile option.

Note: Inline attachments can be enabled only if accessibility features are

disabled.

Personalizations
Some tables allow you to save queries and personalize the presentation of data. If a
table can be personalized, you see the Views panel or the Save Search button.
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Note: Pages can have predefined personalizations available from the

View list. Some pages with no personalizations saved do not show the
Views panel until a search has been saved.

Personalizing Tables
To create a personalized view
1.

Use the search panel to query for results in the table.

2.

Select the Save Search button or the Views button.
•

The Save Search button launches the Create View page.

•

The Views button displays the Views panel. Select the Personalize button to
launch the Personalize Views page. This page displays existing views. Select the
Create View button to launch the Create View page.

3.

On the Create View page, enter a View Name.

4.

Specify the number of rows to display in the table.

5.

Choose the Set as Default check box to make this view the default when you
navigate to this page.

6.

Personalize other available options.
Note: Personalizable options vary by table. Some tables allow you

only to save the search criteria. Others allow you to change more
options, such as columns displayed, column order, sort order, and
headings.

7.

Select the Apply button.

To duplicate, update, or delete a personalized view
1.

Select the Personalize button to launch the Personalize Views page.

2.

Select the view from the list.
•

Select Update to update the options for this view.

•

Select Delete to delete the view.

•

Select the Duplicate button to create a duplicate of the selected view. Enter a
new View Name. Make other modifications as desired and select Apply.
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Using Help

Getting Help
To get help
1.

Choose Window Help from the Help menu, click the Help button on the toolbar, or
press Ctrl+h to display help for the current window:

2.

Navigate to the Contents tab to display online help for any of the Oracle E-Business
Suite products.
Note: You can also choose Oracle Applications Library from the Help

menu.

3.

1.

Click on a product name to display the list of top-level topics in that product's
online documentation.

2.

Click on a topic of interest.

Navigate to the Search tab to find specific Oracle E-Business Suite information.
Simply enter your search criteria in the text field and then press Go. For more
search options click on the Advanced Search link.

For more information see Searching For Help, page A-1.

Searching For Help
You can perform a search to find the Oracle E-Business Suite help information you
want.
1.

Choose Window Help from the Help menu or click the Help button on the toolbar.
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2.

Navigate to the Search tab, enter your search criteria in the text field, then press Go
to perform a simple search. For more search options click on the Advanced Search
link.
A list of titles, ranked by relevance and linked to the documents, is returned from
your search.

3.

Click on whichever title seems to best answer your needs to display the complete
document.
Tip: If the selected document doesn't fully answer your questions,

use the browser's back button to return to the list of titles and try
another.

Simple Search
Simple search implies that the search should return documents that contain any
expression entered in the search field.
The following table lists examples:
Use This Syntax

To Find Documents Containing ...

concurrent managers

the word "concurrent" or the word "managers"

"concurrent managers"

the phrase "concurrent managers"

Advanced Search
The advanced search feature contains these options:
•

All Words

•

Any Words

•

Boolean

All Words
The All Words option implies that the search should return documents that contain ALL
of the expression entered in the search field. For example, if you enter the expression
system administration, the system finds documents containing both "system" and
"administration".
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Any Words
The Any Words option implies that the search should return documents that contain
ANY of the expression entered in the search field. For example, if you enter the
expression system administration, the system finds documents containing either "system"
or "administration".

Boolean
The Boolean option implies that the search should return documents based on the truth
value of the expression entered in the search field. The values for the valid operators
that you can use are shown in the following table:
Operator

Valid Values

And

AND, and, &, +

Or

OR, or, |

Not

NOT, not, -, ~

The following table lists examples:
Use This Syntax

To Find Documents Containing ...

"concurrent manager" & "profile options"

the phrases "concurrent manager" and
"profile options"

"menu options" - "profile options"

the phrase "menu options" and not the phrase
"profile options"

menu & menuitem

the words "menu" and "menuitem".

profile | options

the word "profile" or the word "options"

((profile & categories) ~ options)

the words "profile" and "categories" and not
the word "options"

("concurrent manager" & (request submission))

the phrase "concurrent manager" and the
words "request" and "submission"

Using Help
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Oracle E-Business Suite Accessibility
Features

Oracle E-Business Suite Accessibility Features
The Look and Feel of the User Interface
The Oracle E-Business Suite Professional User Interface can be run with either the Oracle
Look and Feel or the Generic Look and Feel. The Oracle Look and Feel consists of a new look
and feel for each item and a predefined set of color schemes. The Generic Look and Feel
adheres to the native interface and color scheme of the current operating system. The
choice of look and feel has an impact on accessibility features. In general, the Oracle Look
and Feel is the more accessible of the modes. Only low-vision users should find it
necessary to use the Generic Look and Feel.
To specify look and feel, set the profile option Java Look and Feel to either generic or
oracle. If the Oracle Look and Feel is used, the profile option Java Color Scheme can be
specified as follows: blue, khaki, olive, purple, red, swan (default), teal, or titanium.
Note: The Java Color Scheme profile option has no effect if Java Look

and Feel is set to generic.

Important: Setting the Java Color Scheme profile option to a value

other than swan can increase system response time.

Note: Keyboard-only users should set their accessibility mode for

HTML-based applications to Standard to use the keyboard-only
accessible versions of the applications. To set this accessibility mode, set
the profile option Self Service Accessibility Features to Standard
Accessibility.
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Techniques for Low-Vision Users
Low-vision users may find it necessary to control the overall colors of the application,
either to increase or decrease the contrast. They can set the desired colors using the
operating system's provided schemes, then specify generic in the Java Look and Feel
profile option so that Oracle E-Business Suite will use these colors.
Oracle E-Business Suite by default renders required fields in yellow, queryable fields in
a different color while in enter-query mode, and fields that cannot be updated
(read-only fields) in gray. To turn off these features when running Oracle E-Business
Suite Professional User Interface, set profile FND: Indicator Colors to No.

Navigating the Forms-Based Applications Interface
Oracle E-Business Suite offers a feature that can render the current screen in a
compressed, text-only fashion. By invoking the KEY-F9 function, all of the prompts and
values of items in the current window, (just the current row for multi-row blocks), are
displayed within a popup window in a text-only format. Each row can be spoken by a
screen reader. Included in this list are the values of display items or disabled items that
otherwise would not be easily discernible with a screen reader because they are not
keyboard-navigable.
Similarly, the KEY-F8 function shows a list of all buttons within the window and their
access keys, which otherwise would not be obtainable if they were not navigable.
Note: The KEY-F8 and KEY-F9 functions may not be mapped to the

corresponding function keys in your system. Use the Keys window
(Help > Keyboard Help... or Ctrl+k) to view the current mappings for
your system.

Techniques for Physically Disabled Users
Tabs in Oracle E-Business Suite can be switched from the keyboard by using the List
Tab Pages function (typically F2).
Oracle E-Business Suite includes a feature that renders an iconic button next to each
field that has an LOV. The LOV can also be invoked from the keyboard by pressing the
List of Values access key (typically Ctrl+l).
The Keys window displays the keystrokes to achieve normal Oracle E-Business Suite
operations, such as Next Block and Clear Record. This window can be viewed any time by
pressing Ctrl+k.
Oracle E-Business Suite provides the profile option Forms Keyboard Mapping File to
allow a customized keyboard mapping file to be used through the Professional User
Interface. The keyboard mappings can be customized as follows:
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1.

Locate the Oracle Forms resource file on the middle tier, typically called
fmrweb.res.
Note: This step is typically performed by a System Administrator.

2.

Copy the file, rename it as appropriate, and locate it in the same directory as the
original.

3.

Open the new file in any text editor and make the desired keystroke mapping
changes.
Tip: Comments at the top of the file explain how the mappings are

performed.

4.

To run this new mapping file, specify the complete path in addition to the filename
in the profile Forms Keyboard Mapping File.

The Self Service Accessibility Features profile option determines the level of
accessibility support in HTML-based applications.
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